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Povzetek 
Foxit PDF Editor je programsko orodje za urejanje PDF-dokumentov, ki je zaposlenim in 
študentom Univerze v Mariboru na voljo z uporabo digitalne identitete UM. Orodje nudi ob 
urejanju PDF-dokumentov tudi obsežno podporo pri prilagajanju vsebine za boljšo dostopnost 
uporabnikom s posebnimi potrebami. Z njegovo pomočjo lahko urejamo strukturo dokumenta, 
določamo vrstni red branja, dodajamo opise slikam, označujemo tabele ter preverjamo in 
zagotavljamo skladnost s standardi dostopnosti, kot sta WCAG in PDF/UA. Namenjeno je 
ustvarjanju kakovostnih in vključujočih PDF-dokumentov, ki omogočajo enakovreden dostop do 
informacij vsem uporabnikom; tudi tistim, ki uporabljajo bralnike zaslona ali druge podporne 
tehnologije. 

Uporabniška navodila so pripravljena na način, da so izbrane informacije vizualno izpostavljene: 
• simbol     nakazuje tehničen vidik nastavitev v orodju Foxit PDF Editor oz. drugem orodju 

v povezavi z zagotavljanjem dostopnosti dokumenta PDF, 
• izpostavitev primera    dobre prakse, 
• opozorilo na pogosto   slabo prakso, 
• 🎞️ dodaten vir s pojasnilom uporabe orodja ali drugega pomembnega dokumenta.  

https://it.um.si/zaposleni/Strani/default.aspx#id115
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1. Uvod v dostopnost PDF-dokumentov 
Dostopnost elektronskih dokumentov je ključnega pomena za zagotavljanje enakopravnega 
dostopa do informacij vsem uporabnikom. Pri PDF-dokumentih zasledujemo tri ključne plasti 
dostopnosti (Kalita, 2024):  

• izgled: kar vidimo na zaslonu ali natisnjeno na fizičnem dokumentu,  
• vsebino: slike in besedilo z osnovnim oblikovanjem ter opisnimi podatki (npr. pisave, 

barve, tabele) in  
• oznake: strukturo in semantiko dokumenta v ozadju.  

Dostopnost pogosto ni razvidna na prvi pogled, saj je ključna prav nevidna strukturna plast, ki 
omogoča učinkovito uporabo s pomočjo podpornih tehnologij, kot so bralniki zaslona, 
navigacija s tipkovnico ipd. 

Na področju digitalne dostopnosti so uveljavljeni globalni standardi, ki predstavljajo skupen 
referenčni okvir za razvijalce programske opreme in ustvarjalce vsebin. Njihova dosledna 
uporaba zagotavlja, da so dokumenti dostopni širokemu krogu uporabnikov, in sicer ne glede na 
njihove zmožnosti in okoliščine. Med najpomembnejša standarda s področja dostopnosti (PDF-
dokumentov) sodita: 

• WCAG (angl. Web Content Accessibility Guidelines) – smernice za dostopnost 
spletnih vsebin 
Gre za mednarodni standard (ISO), ki določa merila za dostopnost spletnih vsebin na 
splošno in velja tudi za druge digitalne formate, vključno s PDF-dokumenti. Smernice 
WCAG so podlaga številnim nacionalnim in evropskim predpisom, kot sta EN 301 549 
(Evropska unija) in slovenski Zakon o dostopnosti spletišč in mobilnih aplikacij (ZDSMA, 
2018). Slednji nas zavezuje predvsem k sledenju najnižje A in srednje ravni skladnosti AA, 
medtem ko je najvišja raven AAA priporočljiva. 

• PDF/UA (angl. PDF/Universal Accessibility) – univerzalno dostopen PDF-dokument 
Gre za standard DIN ISO 14289, ki natančno opredeljuje zahteve, ki jih mora izpolnjevati 
dostopen PDF-dokument. Poleg vsebinskih vključuje tudi tehnične zahteve za orodja, ki 
ustvarjajo ali berejo PDF-dokumente, ter za podporne tehnologije. Standard PDF/UA 
dopolnjuje WCAG, saj se osredotoča na specifične tehnične vidike dostopnosti PDF-
dokumenta. 

Izhajanje iz WCAG in PDF/UA-priporočil torej predstavlja temelj za pripravo kakovostnih, 
razumljivih in dostopnih učnih gradiv tudi v visokošolskem prostoru. 

🎞️ Dodaten vir: W3C – World Wide Web Consortium (2025). Web Content Accessibility 
Guidelines (WCAG) 2.1. 

  

https://pisrs.si/pregledPredpisa?id=ZAKO7718
https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/
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2. Osnovna priprava dokumenta in izvoz v format PDF 
Dostopnost se začne že pred samim izvozom dokumenta v format .PDF, zato je vedno 
učinkoviteje izhajati iz primarnega vira (npr. v formatu .DOCX, .PPTX). Urejevalniki elektronskih 
gradiv namreč omogočajo enostavnejše in časovno manj zamudno oblikovanje vsebine, hkrati 
pa vključujejo različne pripomočke, namige in druge funkcionalnosti za samodejno odpravo 
težav z dostopnostjo. 

Več smernic za pripravo dostopnih gradiv je na voljo v Iskalniku gradiv (sklop Prilagoditve 
poučevanja). Z vidika specifik formata .PDF pa je smiselno posebno pozornost nameniti 
predvsem naslednjim ključnim elementom (PAC, 2024): 
• Naslov dokumenta in metapodatki: jasno določen naslov omogoča lažjo identifikacijo 

dokumenta in je ključen za orientacijo v digitalnem okolju. Pomembni so tudi drugi 
metapodatki (npr. jezik), na katere se zanašajo podporne tehnologije pri pravilnem 
tolmačenju vsebine. 

• Slog za naslove in podnaslove: omogoča logično strukturo dokumenta, kar olajša 
orientacijo tako bralcem kot tudi podporni tehnologiji. 

• Alternativno besedilo za slike/tabele: zagotavlja, da so vizualne informacije dostopne 
tudi uporabnikom z okvarami vida. 

• Struktura tabel: omogoča smiselno predstavitev podatkov in njihovo pravilno 
interpretacijo z uporabo bralnikov zaslona (npr. označena naslovna vrstica). Priporočen je 
tudi izogib kompleksnim tabelam (npr. s spojenimi celicami, večvrstično glavo). 

• Seznami: urejeni/oštevilčeni in neurejeni seznami izboljšajo preglednost ter olajšajo 
navigacijo po vsebini. Nasprotje dostopnosti predstavljajo t. i. navidezni seznami, ki 
nastanejo z ročnim vnašanjem znakov za označevanje (npr. pomišljajev ali pik), namesto z 
uporabo ustreznih slogov. 

• Stolpci: pravilna uporaba stolpcev prispeva k boljši organizaciji besedila brez zmanjšanja 
dostopnosti. 

• Opisne povezave: zamenjajo generične izraze, kot je »klikni tukaj«, in uporabnikom 
posredujejo jasne informacije o namenu in cilju povezave (npr. format in velikost 
dokumenta v priponki). 

• Velikost pisave: dovolj velika in berljiva pisava izboljša uporabniško izkušnjo za vse, zlasti 
za uporabnike z motnjami vida. 

• Kontrast: ustrezen barvni kontrast med besedilom in ozadjem je ključen za berljivost 
vsebine. Tudi sicer je smiselno informacije podajati neodvisno od vsebine (npr. grafikoni ali 
rezultati v tabelah niso podani zgolj z barvo). 

V pomoč pri oblikovanju vsebine v pisarniških orodjih družine Microsoft je Pomočnik za 
dostopnost (slika 1;    Datoteka > Informacije > Preveri dostopnost), ki omogoča enostavnejšo 
in hitrejšo ureditev osnovnih vidikov dostopnosti elektronskih gradiv (npr. informacije o datoteki, 
uporaba vgrajenih slogov, zapis nadomestnih besedil, kontrast barv, zgradba tabel). 

https://didakt.um.si/gradiva/Strani/Iskalnik-gradiv.aspx
https://didakt.um.si/gradiva/Strani/Iskalnik-gradiv.aspx
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Slika 1: Predlogi Pomočnika za dostopnost v Wordu 

2.1 Izvoz v format .PDF 

Pri pretvorbi dokumenta v format .PDF je priporočljivo uporabiti način izvoza, ki ohrani strukturo 
dokumenta, oznake za dostopnost in druge ključne metapodatke. S tem zagotovimo, da se 
osnovne zahteve za dostopnost prenesejo neposredno iz izvorne datoteke, kar močno 
poenostavi nadaljnje preverjanje in urejanje v specializiranih orodjih, kot je Foxit PDF Editor. 

   Dobra praksa: Za najučinkovitejšo pretvorbo besedilnega dokumenta (npr. v formatu 
.DOCX) v PDF je priporočljiva uporaba namenskega gumba/vtičnika (   zavihek Foxit PDF > 
Create PDF), ki se v urejevalniku besedil Word doda ob namestitvi orodja Foxit PDF Editor (slika 
2).  

 
Slika 2: Zavihek Foxit PDF v Wordu za izvoz dokumenta v format .PDF 
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Uporaba orodja Foxit omogoča natančnejše ohranjanje strukturnih oznak (če so te dosledno 
uporabljene v primarnem dokumentu), kar pomembno prispeva k boljši dostopnosti končnega 
PDF-dokumenta in poenostavi njegovo naknadno preverjanje. 

  Slaba praksa: Popolnoma neprimerna je pretvorba v PDF s funkcionalnostjo tiskanja 
(   Datoteka > Natisni > Microsoft Print to PDF), saj ta v večini primerov ne ohrani strukturnih 
značilnosti dokumenta. Več ročnega urejanja je običajno potrebnega tudi pri izvozu z 
namenskim gumbom za ustvarjanje PDF-dokumenta (   Datoteka > Izvozi > Ustvari dokument 
PDF/XPS).  
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3. Uporabniški vmesnik Foxit PDF Editor 
Ključne funkcionalnosti za urejanje dostopnosti so zbrane v zavihku Accessibility (slika 3) oz. iz 
podokna za krmarjenje (angl. Navigation Pane) na levi strani zaslona (slika 4). Uporabniku so na 
voljo različne možnosti za urejanje posameznih vidikov dostopnosti: 

A. Preverjevalnik dostopnosti (angl. Accessibility Check): omogoča pregled skladnosti 
dokumenta s smernicami WCAG 2.1 in ponuja priporočila za izboljšave z možnostjo 
strojne odprave oz. pojasnila o vplivu na uporabnike. 

B. Vrstni red branja (angl. Order): omogoča pregled in nastavitev pravilnega zaporedja 
vsebine za bralnike zaslona. 

C. Nadomestno besedilo (angl. Set Alternate Text): dodajanje opisov slikam in drugim 
vizualnim elementom, kar omogoča dostop tudi uporabnikom z motnjami vida. 

D. Strukturne oznake (angl. Tags): urejanje osnovnih oznak v dokumentu (npr. naslovi, 
povezave, seznami), ki omogočajo pravilno interpretacijo vsebine. 

E. Zaznamki (angl. Bookmarks): vstavljanje in upravljanje zaznamkov, ki olajšajo navigacijo 
po dokumentu, zlasti za uporabnike podpornih tehnologij. 

 
Slika 3: Funkcionalnosti v zavihku Accessibility za urejanje dostopnosti s Foxit PDF Editorjem 

 

 
Slika 4: Podokno za krmarjenje z izvedeno analizo preverjevalnika dostopnosti 
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   Dobra praksa: Za razlago posameznih funkcionalnosti ali gumbov uporabniškega vmesnika 
je na voljo dodatna pomoč (slika 5), ki se prikaže v oknu posameznega gumba pod povezavo 
Razloži več (angl. Tell me more). Ta razlaga vključuje kratek opis funkcionalnosti in pogosto tudi 
povezavo na ustrezno poglavje v spletnem vodniku. Celoten center za pomoč (angl. Help Center) 
je dostopen prek zavihka Pomoč (angl. Help), kjer so na voljo tudi uporabniška navodila za 
nameščeno različico orodja Foxit PDF Editor.  

 
Slika 5: Prikaz dodatne pomoči z razlago funkcionalnosti Pomočnik za dostopnost in povezavo 
do spletnega vodnika (v oknu na desni strani zaslona) 

   Dobra praksa: V podoknu za krmarjenje lahko spreminjamo prikaz gumbov in ročno dodamo 
želene možnosti za urejanje dostopnosti (   View > View Setting > Navigation Panels > npr. Tags, 
Content, Order …). Možnost spremembe nabora gumbov je na voljo tudi z desnim klikom na 
prazen prostor v podoknu za krmarjenje (slika 6). 

 
Slika 6: Sprememba nabora gumbov za urejanje dostopnosti z desnim klikom v podoknu za 
krmarjenje  
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4. Pripomočki za strojni pregled dostopnosti 
Foxit PDF Editor omogoča hitro in sistematično preverjanje skladnosti PDF-dokumenta z 
osnovnimi tehničnimi načeli dostopnosti. Čarovnik opravil (angl. Action Wizard: Make 
Accessible) in preverjevalnik dostopnosti (angl. Accessibility Checker) omogočata avtomatiziran 
pregled, ki močno olajša preverjanje dostopnosti, vendar ne nadomeščata ročne preverbe 
ugotovitev. Uporabnik mora še vedno sam presoditi ustreznost samodejno izvedenih popravkov 
(npr. določene oznake, smiselnost nadomestnih opisov slik) ter opraviti ročne prilagoditve (npr. 
ureditev logike vrstnega reda branja, izbor ustreznega kontrasta barv, zapis opisnih URL-spletnih 
povezav). Testni katalog za skladnost s standardom PDF/UA vsebuje namreč 136 pogojev za 
napake, od katerih jih je možno samodejno preveriti le 108 (PAC, 2025). 

4.1 Čarovnik opravil: dostopnost (angl. Action Wizard: Make Accessible) 

Različica Foxit PDF Editor PRO vključuje funkcionalnost »čarovnik opravil« (   File > Action 
Wizard > Make Accessible > Start), ki uporabnika korak za korakom vodi skozi ključne 
nastavitve za izboljšanje osnovnih vidikov dostopnega dokumenta (slika 7). 

Med drugim omogoča: 
• nastavitev metapodatkov (angl. Add Document Description), kot so naslov dokumenta 

(angl. Title), avtorja (angl. Author), ključnih besed (angl. Keywords) za pravilen zapis ob 
objavah dokumenta, 

• prepoznavanje besedila na skeniranih straneh oz. slikah (angl. Recognize Text) za 
prepoznavo znakov v dokumentu (funkcionalnost OCR - Optical Character Recognition),  

• določitev jezika vsebine oz. branja (angl. Set Reading Language) za pravilno izgovorjavo v 
bralnikih zaslona, 

• prepoznavanje obrazcev (angl. Detect Form Fields) za dodatne nastavitve navigacije v teh, 
• samodejno prepoznavanje oznak (angl. Autotag Document), 
• dodajanje nadomestnega besedila (angl. Set Alternative Text) za slike in druge vizualne 

elemente oz. njihovo označitev v dekorativni vlogi za umik iz podpornih tehnologij, 
• pregled s preverjevalnikom dostopnosti (angl. Accessibility Checker) in izdelavo poročila 

(podrobno obravnavano v poglavju 4.2). 
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Slika 7: Osnovni pregled dostopnosti v dokumentu s čarovnikom opravil (angl. Action Wizard: 
Make Accessible) v različici Foxit PDF Editor PRO 

Postopek v čarovniku opravil je mogoče kadarkoli prekiniti (gumb Stop) in nadaljevati kasneje 
(gumb Resume). Opravljeni koraki so v uporabniškem vmesniku označeni s kljukico (  ), 
medtem ko so nedokončani koraki označeni z opozorilom (   ), kar omogoča dober pregled nad 
napredkom urejanja. 

Za pregled dostopnosti je na voljo tudi funkcionalnost »čarovnik opravil« za takojšnje preverjanje 
skladnosti s standardom PDF/UA (    File > Action Wizard > Make Accessible (PDF/UA-1)), ki 
uporabniku ponuja manj nadzora nad posameznimi nastavitvami (npr. izpuščena zaznava 
obrazcev, dodajanje oznak v ozadju), vendar dokument samodejno pretvori in shrani v format 
PDF/UA. Funkcionalnost je zato primernejša za naprednejše uporabnike ali za hiter izvoz, kadar 
je dokument že ustrezno pripravljen v skladu s pravili o dostopnosti in ne zahteva večjih 
prilagoditev. 

🎞️ Dodaten vir: Foxit (2021). PDF Accessibility. Create accessible PDF documents with Action 
Wizard [Video]. YouTube. 

  Slaba praksa: Z nepremišljeno uporabo funkcionalnosti OCR za prepoznavanje besedila na 
skeniranih straneh lahko v dokumentu nehote ustvarimo množico nepovezanih informacijskih 
elementov (npr. imena gumbov, menijev, številke, sistemska obvestila), ki bodo uporabnikom s 
podpornimi tehnologijami oteževali razumevanje vsebine. Na primer pretvorba zaslonskega 
posnetka z uporabniškim vmesnikom v besedilo (slika 8) se v praksi izrazi kot strojno branje vseh 
gumbov/menijev na posnetku in dodatna obremenitev bralca. Funkcionalnosti OCR zato ni 
priporočljivo uporabljati privzeto, temveč le takrat, ko je jasno, da slika vsebuje relevantno in 

https://youtu.be/BsKakeWLyNY?si=VJcs_BKxQwFzYSxI
https://youtu.be/BsKakeWLyNY?si=VJcs_BKxQwFzYSxI
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strukturirano besedilo, ki bi ga bilo sicer nemogoče prebrati (npr. skenirana stran dokumenta ali 
članek).  

 
Slika 8: Zaslon s prepoznanim besedilom prek funkcionalnosti OCR, ki je na zaslonskem posnetku 
uporabniškega vmesnika ustvarila množico oznak (v podoknu na levi in okvirji na sliki) in bi jih 
bralnik zaslona uporabniku podal kot običajno besedilo  

   Dobra praksa: Pred prvo uporabo čarovnika opravil Make Accessible ali Make Accessible 
(PDF/UA-1) je priporočljivo namestiti ustrezne jezikovne pakete za OCR. Nastavitev   : Help > 
About Foxit PDF Editor > Check for Update > Download and Install (slika 9). Pri dokumentih, 
ki so skenirani ali shranjeni kot slika, bo čarovnik sprožil opozorilo in ponudil možnost za optično 
prepoznavo znakov (OCR). Če je ob tem nameščen ustrezen jezikovni paket, bo prepoznava 
znakov natančnejša (npr. brez napak pri šumnikih) in primernejša za bralnike zaslona. 
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Slika 9: Namestitev slovenščine za optično prepoznavo znakov OCR (angl. Optical Character 
Recognition) 

4.2 Preverjevalnik dostopnosti (angl. Accessibillity Check) 

Podroben pregled skladnosti PDF-dokumenta s smernicami WCAG 2.1 omogoča preverjevalnik 
dostopnosti (    Accessiblility > Full Check > Start Checking), pri katerem je možno prilagoditi 
obseg pregleda (slika 10). Če so določene možnosti izpuščene, so v rezultatih označene kot 
preskočene (    z oznako Skipped). Te je mogoče naknadno preveriti bodisi z novim zagonom 
preverjanja bodisi posamično z desnim klikom na gumb Check Again oz. z odstranitvijo izbire pri 
Skip Rule. 

Rezultate pregleda je možno tudi izvoziti v obliki poročila (    Accessiblility > Accessibility 
Report), ki se shrani na izbrano lokacijo naprave ali pripne dokumentu. Če poročilo ni bilo 
izdelano, je podrobna razlaga posameznih vidikov dostopnosti (prek gumba Explain) dostopna le 
prek spletne pomoči, saj gumb Show Report v tem primeru prikaže prazno stran. 
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Slika 10: Okno z nastavitvami obsega pregleda pred zagonom preverjevalnika dostopnosti (angl. 
Accessibillity Check) 

Rezultati so v podoknu za preverjanje dostopnosti prikazani v obliki seznama (slika 11), 
razdeljenega po kategorijah (dokument, slike, tabele, zaznamki ipd.). Vsaka postavka ima enega 
od naslednjih statusov: 
•    Uspešno opravljen pregled (angl. Passed), 
•    Potrebno ročno preverjanje (angl. Needs manual check) – velja za elemente, kot so 

vrstni red branja ali barvni kontrasti, 
•   Neuspešno preverjanje z ugotovljenimi napakami (angl. Failed), 
•     Izpuščen pregled (angl. Skipped), ko element ni bil preverjen ali pa preverjanje ni bilo 

mogoče. 

Z desnim klikom na posamezne elemente se odpre kontekstni meni z naslednjimi možnostmi: 
• Popravi (angl. Fix): samodejno odpravi napako, ali se odpre okno za ročno odpravo (npr. 

nadomestni opisi slik, naslov dokumenta). Možnost ne deluje za vse napake in je na voljo 
le v PRO različici. 

• Preskoči pravilo (angl. Skip Rule): vidika ne preverja, stanje elementa pa spremeni v 
Skipped. 

• Pojasni (angl. Explain): odpre spletno pomoč z razlago napake oz. postopka. 
• Ponovno preveri (angl. Check Again): znova preveri vse elemente izbranega vidika. 
• Prikaži poročilo (angl. Show Report): v podoknu za krmarjenje odpre poročilo o 

dostopnosti (angl. Accessibility Report), če je poročilo na voljo oz. je shranjeno. 
• Možnosti (angl. Options): odpre pogovorno okno preverjevalnika dostopnosti za nastavitev 

obsega ponovnega preverjanja. 
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• Potrdi (angl. Pass): stanje elementa spremeni v »Ročno potrjeno kot ustrezno«, če 
uporabnik ugotovi, da element izpolnjuje merila dostopnosti. 

• Zavrni (angl. Fail): stanje elementa spremeni v »Ročno potrjeno kot neuspešno«, če 
uporabnik ugotovi, da element NE izpolnjuje meril dostopnosti. 

 
Slika 11: Prikaz poročila o dostopnosti v Foxit PDF Editorju z možnostjo preskoka, razlage ali 
ponovnega pregleda posamezne možnosti 

   Dobra praksa: Preverjevalnik dostopnosti (angl. Accessibillity Check) lahko uporabimo tudi 
kot dodatno kontrolo po ročni ureditvi dokumenta. S tem zagotovimo, da noben pomemben vidik 
dostopnosti ne ostane spregledan.  
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5. Dodajanje in urejanje oznak 
Oznake (angl. Tags) opisujejo logično in semantično strukturo dokumenta (npr. naslove, 
odstavke, sezname, povezave) in predstavljajo temelj dostopnega PDF-dokumenta. Brez 
ustreznih oznak na primer bralniki zaslona ne morejo pravilno interpretirati vsebine, zato jo 
podajajo v enoličnem in neprekinjenem tonu, brez ločevanja med posameznimi sklopi 
informacij. Foxit PDF Editor omogoča dva načina urejanja oznak: 
• Samodejno označevanje (angl. Autotag Document), ki je primernejše za enostavnejše 

dokumente (npr. izvoz iz Worda) ali za začetni korak pri strukturiranju, 
• Ročno dodeljevanje oznak, ki omogoča natančno prilagoditev in je nujno za 

kompleksnejše dokumente (npr. tabele, več stolpične postavitve, obrazci). 

Pravilna struktura oznak mora biti vedno usklajena z vrstnim redom branja (angl. Reading 
Order), da dokument ostane logično in funkcionalno dostopen tudi uporabnikom podpornih 
tehnologij. 

   Dobra praksa: Urejevalniki vsebin (npr. Microsoft Word, PowerPoint) zelo dobro podpirajo 
različne vidike dostopnosti, ki se ob izvozu solidno prenesejo tudi v PDF-dokument. Dosledna 
uporaba slogov (slika 12; npr. naslov, podnaslov, navadno besedilo, napis), ustrezno 
označevanje seznamov ter specifikacija tabel (npr. nastavitev naslovne vrstice) že v izvorni 
datoteki pomenijo občuten prihranek časa pri kasnejšem urejanju dostopnosti v PDF-ju. V praksi 
je zato pogosto učinkoviteje, da se za ureditev dostopnosti najprej vrnemo v primarni dokument 
in se šele nato lotimo nadaljnjega urejanja z orodjem Foxit PDF Editor. 

 
Slika 12: Slogi iz urejevalnika Word se prenesejo tudi v PDF-dokument (npr. Naslov 2 ustreza 
oznaki <H2>) 

5.1 Samodejno označevanje dokumenta 

Samodejno označevanje dokumenta je v različici PRO dosegljivo iz zavihka za dostopnost (    
Accessiblility > Autotag Document). Ob zagonu funkcionalnosti program sam analizira 
postavitev vsebine in dodeli oznake osnovnim elementom, kot so naslovi, odstavki, slike, 
povezave, tabele, seznami in drugi vsebinski deli, ki se pokažejo v podoknu za krmarjenje (na levi 
strani). Če dokument oznake že vsebuje (npr. prenesene iz urejevalnika Word), Foxit uporabnika 
predhodno opozori na ponovno dodelitev oznak (slika 13). 
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Slika 13: Samodejno označevanje dokumenta z opozorilom o že obstoječih oznakah  

   Dobra praksa: V preprostejših dokumentih je rezultat samodejnega podeljevanja oznak 
pogosto zadovoljiv: besedilo je ustrezno razvrščeno, osnovni elementi so prepoznani, struktura 
pa je dovolj pregledna za nadaljnjo obdelavo ali uporabo z bralniki zaslona. Pri daljših ali 
kompleksnejših dokumentih (npr. več poglavij, priloge, več stolpična postavitev) pa samodejno 
označevanje ni vedno povsem zanesljivo (slika 14). Pogosto se zgodi, da so oznake nepravilno 
gnezdene, manjkajo logične vsebinske enote (npr. <Part>, <Sect>), ali pa je vrstni red oznak v 
neskladju z naravno strukturo dokumenta (npr. pomešani odstavki, preskakovanje naslovov). 
Uspešnost funkcionalnosti je v veliki meri odvisna od kakovosti izvorne vsebine (npr. dosledna 
uporaba slogov v Wordu ali dobro strukturiran HTML). 

Po izvedbi postopka je zato vedno priporočljivo pregledati dodeljene oznake in jih po potrebi 
ročno prilagoditi. 

 
Slika 14: Samodejno ustvarjanje oznak je pravilno prepoznalo le del vsebine, ki je v okviru 
pregledane enote/strani <Part> obkrožen z modro, medtem ko je preostanek dokumenta ostal 
neoznačen  
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5.2 Ročno dodajanje oznak 

Pregled in urejanje oznak v dokumentu je najlažje dosegljivo prek podokna za krmarjenje (na levi 
strani zaslona). Če gumb Tags (Oznake) ni privzeto prikazan, ga omogočimo z desnim klikom v 
prazno območje podokna in izborom ustrezne ikone. 

Oznake so prikazane v obliki hierarhičnega drevesa, pri čemer je vsaka povezana s konkretnim 
elementom vsebine (npr. naslovom, odstavkom, sliko). Med najpogostejšimi so: 
• <P>, <Span> – običajni odstavki besedila, 
• <H1>, <H2>, <H3> … – naslovi različnih ravni oz. podnaslovi, 
• <L> – oštevilčen ali neurejen seznam, <LI> – element seznama, <Lbl> – simbol posamezne 

vrstice, <LBody> – vsebina vrstice (npr. poved brez začetnega simbola), 
• <Table> – tabela, <TR>, <TD> – vrstice in celice s podatki, <TH> – naslovne vrstice, 
• <Link> ali <A> – hiperpovezave do drugih delov dokumenta ali zunanjih virov, 
• <Figure> – slike ali grafike, 
• <Sect>, <Part>, <Art> – smiselne vsebinske enote/celote (npr. poglavja, priloge). 

Uporabniški vmesnik omogoča urejanje zaporedja oznak z uporabo funkcije vleci in spusti (t. i. 
Drag and Drop) ter gnezdenje znotraj drugih oznak. Hkrati omogoča vizualen pregled ujemanja 
med posamezno oznako in dejansko vsebino v dokumentu, saj se ob kliku na oznako označi 
pripadajoče besedilo ali objekt v dokumentu. Z gumbom Možnosti (angl. Options) ali desnim 
klikom na posamezno oznako (možno tudi za več izbranih oznak hkrati) se odpre kontekstni 
meni, ki vključuje številne uporabne ukaze za ročno upravljanje oznak: 
• New Tag – dodajanje nove oznake, 
• Cut – izrez označenega elementa, 
• Delete – brisanje izbrane oznake, 
• Delete Empty Tag – brisanje prazne oznake brez vsebine, 
• Reading Order – prikaz bralnega vrstnega reda z možnostjo prilagoditve, 
• Find Tag from Selection – iskanje oznake, ki pripada trenutno označenemu delu 

dokumenta in olajša preverjanje ustreznosti že obstoječih oznak, 
• Create Tag from Selection – dodajanje oznake iz trenutno označene vsebine v 

dokumentu, 
• Find – iskanje oznak po imenu ali vrsti, 
• Change Tag to Artifact – pretvorba oznake v artefakt (npr. za dekorativne elemente), 
• Properties – ogled in urejanje lastnosti oznake (npr. sprememba tipa oznake iz <p> v 

<link>, popravek vsebine, atributi). 

Ročno dodajanje oznak v praksi najpogosteje poteka z enim oz. kombinacijo treh postopkov: 
A. Sprememba obstoječe oznake: V podoknu Tags poiščemo in označimo želeni element 

(npr. <Span>) ter prek menija odpremo okno z lastnostmi oznake (   Tags > (npr. <Span>) 
> Options > Properties). V odprtem oknu (slika 15) lahko spremenimo tip oznake (Type) 
(npr. iz <Span> v <H2>) in po potrebi oznako prestavimo na pravo mesto v drevesni 
strukturi (dolga črtica označuje novo raven, polovična pa ugnezditev pod obstoječi 
element). Možnost je primerna predvsem za enostavne spremembe (npr. iz besedila v 
naslov, sliko v okrasni artefakt), saj kompleksnejši elementi zahtevajo tudi druge 
nastavitve (npr. ciljno mesto spletne povezave, določitev celotne strukture seznama). 
Sprememba tipa oznake namreč spremeni zgolj njeno oznako v strukturi, ne pa tudi 
njene funkcionalnosti. 
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Slika 15: Okno z lastnostmi obstoječe oznake <Span>, kjer je mogoča sprememba tipa (npr. v 
<H2>), opisa in drugih metapodatkov 

B. Ustvarjanje oznake iz označenega besedila: v dokumentu označimo (Home > Select) 
vsebino (npr. odstavek ali naslov) in v podoknu Tags izberemo gumb za ustvarjanje 
oznake (slika 16;    Tags > Options > Create Tag from Selection). Odpre se okno za 
določitev tipa oznake, ki bo določena za vsebino (npr. <P>, <H1>, <Figure>). 
Funkcionalnost oznako običajno ustvari na koncu seznama (razen če je označena druga 
skupina), zato jo je treba postaviti na pravo mesto. 

 
Slika 16: Nova oznaka iz označenega besedila prek možnosti Create Tag from Selection 
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C. Označevanje oznak med urejanjem vrstnega reda branja: v zavihku dostopnosti 
odpremo okno za nastavitev vrstnega reda branja (   Accessibillity > Reading Order), ki 
bo omogočalo določanje oznak. Nato v dokumentu z miško označimo izbrano območje 
dokumenta (npr. odstavek), določimo tip vsebine (npr. besedilo, slika, naslov) in s tem 
samodejno ustvarimo pripadajočo oznako (slika 17). Oznaka je dodana na dno strukture 
in jo je treba po potrebi premakniti na ustrezno mesto v drevesni strukturi oznak. 
Urejanje oznak je po nekoliko kompleksnejši poti dosegljivo tudi iz podokna za 
krmarjenje (    Order) in okna za izbiro območij vrstnega reda branja (   Accessibillity > 
Set Area Reading Order). 

 
Slika 17: Zamenjava oznake <TOCI> v <P> prek podokna za vrstni red branja 

Za zagotavljanje pravilne in pregledne strukture dokumenta je priporočljivo, da so oznake 
vsebinsko smiselno organizirane, torej da so naslovi in odstavki vključeni v večje logične enote 
(npr. <Sect>, <Part>), in da struktura sledi naravni vsebinski logiki besedila, ki je usklajena z 
vrstnim redom branja (angl. Reading Order). 

🎞️ Dodaten vir: Foxit (2021). PDF Accessibility. How to tag your PDFs with the reading order tool 
[Video]. YouTube. 

🎞️ Dodaten vir: Foxit (2021). PDF Accessibility. How to make lists more accessible in PDF 
documents [Video]. YouTube. 

   Dobra praksa: Med pregledom oznak je smiselno pozornost nameniti tudi praznim oznakam 
ali vrsticam, ki ne vsebujejo nobene uporabne vsebine. Takšne oznake lahko nastanejo pri 
samodejnem označevanju ali med ročnim oblikovanjem vsebine (npr. postavitev besedila brez 
uporabe zamika) in niso informacijsko pomembne. Ker jih bralniki zaslona vseeno preberejo, 
lahko zmedejo uporabnika podpornih tehnologij in jih je bolje odstraniti (slika 18). 

https://youtu.be/zngcd4avcSI?si=Ttunp7-KH63CdfnS
https://youtu.be/zngcd4avcSI?si=Ttunp7-KH63CdfnS
https://youtu.be/xq9_BzqsFDg?si=5AgqsZvAyCX8vtAp
https://youtu.be/xq9_BzqsFDg?si=5AgqsZvAyCX8vtAp
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Slika 18: Izbris praznih vrstic (   Tags > Options > Delete Tag), ki so bile namenjene oblikovanju 
vsebine  
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6. Določitev vrstnega reda branja 
Vrstni red branja predstavlja ključni navigacijski vidik dostopnosti PDF-dokumentov. Za 
uporabnike podpornih tehnologij (npr. bralniki zaslona, navigacija s tipkovnico) ni pomembno le, 
da je vsebina pravilno označena, temveč tudi v kakšnem zaporedju se ta vsebina predstavi. Če 
so elementi nepravilno razvrščeni (npr. branje slike pred naslovom ali na koncu celotne vsebine), 
lahko uporabnik izgubi rdečo nit, napačno razume vsebino, ali prezre pomembne dele 
dokumenta. Da bi se temu izognili, mora vrstni red branja slediti naravni in logični strukturi 
dokumenta (npr. najprej številka strani, nato naslov, odstavki, slike, tabele). 

Določitev in pregled vrstnega reda branja v praksi najpogosteje poteka z enim od dveh 
funkcionalnosti, ki se dopolnjujeta s seznamom za določanje vrstnega reda (angl. Order) v 
podoknu za krmarjenje (na levi strani zaslona): 
A. Določitev vrstnega reda branja in ustvarjanje oznak (    Accessibility > Reading Order): 

Funkcionalnost Reading Order odpre okno Touch Up Reading Order, na dokumentu pa se 
prikažejo oštevilčeni okvirji, ki označujejo vrstni red, v katerem bodo ti prebrani (slika 19). 
Uporabnik nato v dokumentu z miško označuje posamezno vsebino in ji v oknu z 
namenskimi gumbi določa oznako (npr. besedilo, naslov, slika, tabela). Določeno zaporedje 
branja se doda v strukturni seznam dokumenta pod Order, ki je dosegljiv v podoknu za 
krmarjenje (na levi strani zaslona) ali neposredno v odprtem oknu z gumbom Show Order 
Panel. Seznam hkrati predstavlja kontrolno točko za spremljanje obstoječega zaporedja, pri 
čemer se lahko med označenimi elementi prosto premikamo in jih po sistemu povleci in 
spusti urejamo v novo zaporedje. 

 
Slika 19: Oštevilčeni okvirji v funkcionalnosti Reading Order prikazujejo vrstni red branja 
elementov, ki ga po potrebi spreminjamo tudi v seznamu podokna Order (na levi strani) 
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Pri določanju vrstnega reda branja je pogosto treba oceniti, ali je enostavneje/učinkoviteje 
vrstne rede na posamezni strani popravljati ali počistiti (gumb Clear Page Structure) in 
začeti znova. 

B. Vrstni red branja po območjih (    Accessibility > Set Area Reading Order): 
Podobna je tudi raba nastavitve vrstnega reda branja po območjih (angl. Set Area Reading 
Order), ki omogoča vizualno in učinkovitejše urejanje vrstnega reda branja neposredno v 
pogledu dokumenta. Uporabnik označi območja okoli izbranih vsebin v dokumentu (gumb 
Change Area Order), nato pa za vsako območje določi želeni vrstni red branja. Kliki na 
zaporedno številko območja namreč ustvarijo pot branja, ki jo prikazuje rdeča puščica (slika 
20). Ta funkcionalnost je posebej uporabna pri dokumentih z več stolpci ali bolj kompleksno 
postavitvijo, saj je bistveno hitrejša in preglednejša kot ročno razvrščanje oznak v podoknu 
Order. Potrjene spremembe (gumb Apply Area Order) so vidne tudi v podoknih Content in 
Order (na levi strani zaslona). 

 
Slika 20: Pri določitvi vrstnega reda branja za območje se s kliki na posamezne označene okvirje 
z vsebino povežejo s puščico v izbrano zaporedje (gumb Change Area Order) 
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   Dobra praksa: Med pregledom vrstnega reda branja je smiselno del pozornosti nameniti tudi 
oznakam (slika 21). Okrasne elemente (npr. logotipi, razdelne črte) tako označimo kot artefakte, 
da jih podporne tehnologije izvzamejo iz sporočanja vsebine. 

 
Slika 21: Označitev logotipa kot okrasni element oz. artefakt (   Order > desni klik > Tag as 
background/artifact) 

   Dobra praksa: Določitev vrstnega reda elementov v PowerPoint predstavitvi je enostavneje 
opraviti s Pomočnikom za dostopnost (slika 22;    Datoteka > Informacije > Preveri dostopnost > 
Podokno »Vrstni red branja«) in ga šele nato izvoziti v PDF format. 

 
Slika 22: Nastavitev vrstnega reda branja v okviru Pomočnika za dostopnost v MS PowerPoint  
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7. Urejanje nadomestnih besedil za slike 
Slike, grafikoni in druge vizualne informacije so za slepe ali slabovidne uporabnike nevidne, če 
jim ni dodan nadomestni opis (t. i. alternativno besedilo). Nadomestno besedilo omogoča 
bralnikom zaslona, da posredujejo vsebino slike uporabniku, drugim pa se lahko prikaže ob 
premiku miške nad sliko, ali kadar slika ni pravilno naložena. 

Foxit PDF Editor omogoča nastavitev nadomestnega besedila za vse slike v dokumentu prek 
zavihka za dostopnost (    Accessiblility > Set Alternate Text). Pogoj za delovanje 
funkcionalnosti je, da so elementi ustrezno označeni kot slike oz. <Figure>. Ob prvem zagonu se 
običajno prikaže pogovorno okno z obvestilom, da bo orodje zaznalo vse slike. Sledijo vnosna 
polja za vsako sliko (slika 23) in prikaz morebitnih že obstoječih nadomestnih opisov. Med 
slikami se premikamo s puščicami, za slike brez vsebinske vrednosti pa lahko označimo polje 
Decorative figure, kar pomeni, da jih bralniki zaslona preskočijo. 

 

Slika 23: Pogovorno okno za vnos nadomestnega besedila, v katerem je slika tarče označena kot 
dekorativna, zato je bralnik zaslona ne prebere 

Enaka funkcionalnost je na voljo tudi v PRO različici orodja, in sicer kot del čarovnika opravil 
(angl. Action Wizard: Make Accessible), pri katerem se preverjanje dostopnosti izvaja 
sistematično. 

Nastavitev nadomestnega besedila za posamezno sliko je možna prek funkcionalnosti za 
določanje vrstnega reda branja (    Accessibility > Reading Order). Ko je odprto okno Touch Up 
Reading Order (slike so prekrižane), lahko z desnim klikom na sliko izberemo možnost Edit 
Alternate Text (slika 24), kar odpre vnosno polje za opis slike (angl. Alternate Text). 
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Slika 24: Pogovorno okno za dostop do vnosnega polja za zapis nadomestnega besedila na 
posamezni sliki 

  Slaba praksa: Nadomestno besedilo, kot je »Slika s prikazom pajkovega diagrama«, bo 
bralnik zaslona prebral kot »Slika. Slika s prikazom pajkovega diagrama«, saj bralniki sami 
napovejo tip elementa (npr. <Figure> oz. Slika). Nadomestno besedilo naj torej ne vsebuje vrste 
elementa, ampak jedrnato opiše prizor, s poudarkom na bistvenih informacijah, ki jih želimo 
uporabniku sporočiti.  
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8. Dostopnost tabel 
Tabele pogosto predstavljajo izziv za bralnike zaslona in druge podporne tehnologije, saj 
zahtevajo natančno interpretacijo podatkov in same podatkovne strukture, kot so vrstice, 
stolpci, glave vrstic in stolpcev ipd. Če te niso nujne, se je priporočljivo izogniti uporabi 
kompleksnih tabel (npr. z več glavami, spojenimi celicami ali gnezdenimi strukturami), oziroma 
jih nadomestiti z enostavnejšimi postavitvami, ki omogočajo boljšo razčlenitev podatkov in 
prihranek časa z nastavitvami dostopnosti. 

Nastavitev strukture tabele z vidika dostopnosti je dosegljiva prek funkcionalnosti za določanje 
vrstnega reda branja (    Accessibility > Reading Order > Table Editor). Z urejevalnikom tabel 
lahko nastavljamo vrsto posameznih celic, ustvarjamo identifikacije (ID) za glave ter določamo 
relacije med glavo in podatki. Gumb urejevalnika (angl. Table Editor) v oknu Touch Up Reading 
Order postane aktiven le, ko je izbrana tabela (klik na del strukturnega objekta <Table>) in ko je 
omogočena možnost za prikaz tabel in slik (angl. Show tables and figures). Urejevalnik tabel 
(slika 27) je sicer dosegljiv tudi z desnim klikom na tabelo v dokumentu ali z desnim klikom na 
oznako <Table> v podoknu Tags. Urejevalnik zapustimo s klikom na prazen prostor izven 
obstoječih območij ali preklopom na drugo funkcionalnost. 

Ko je urejevalnik tabel aktiven, so vse posamezne celice označene z barvnimi obrobami (slika 
25), kar uporabniku olajša pregled ustreznosti (npr. temno rdeča za obrobo tabele, roza celice za 
glavo oz. naslovne vrstice/stolpce, sive celice za celice s podatki, modra za spojene celice). 
Barvo in ostale nastavitve urejevalnika tabel je mogoče prilagajati (gumb Table Editor Options).  

 
Slika 25: Pravilno označena tabela z nastavljeno naslovno prvo vrstico in prvim stolpcem (TH) ter 
odprtim pogovornim oknom Table Editor Options za prilagoditev barv za lažji pregled strukture 
tabele  

Urejanje lastnosti celic je na voljo z desnim klikom na celico (možnost Table Cell Properties), 
pri čemer mora imeti vsaka celica določene naslednje parametre (slika 26): 
• Tip (angl. Type):  

o Glava tabele (TH – Header Cell), ki mora imeti določen tudi obseg (npr. naslovna vrstica 
– Row, naslovni stolpec Column),  

o Podatkovna celica (TD – Data Cell). 
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•  Atributi (angl. Attributes) – ti so posebej pomembni pri kompleksnih tabelah s spojenimi 
celicami: 
o Obseg vrstic (angl. Row Span): število vrstic, ki jih celica pokriva; običajno 1, razen pri 

spojenih celicah. 
o Obseg stolpcev (angl. Column Span): število stolpcev, ki jih celica pokriva; običajno 1. 
o ID: vrednost ID-naslovne celice, ki omogoča, da podporne tehnologije pravilno 

povežejo naslovne in podatkovne celice. ID-je je mogoče določiti samodejno (gumb 
Auto Generate Header Cell IDs), priporočljivo pa je ročno poimenovanje z logičnimi 
oznakami za boljši nadzor. 

o Podatek o povezanih ID-jih (angl. Associated Head Cell IDs): ročna dodelitev povezav 
med podatkovnimi in pripadajočimi naslovnimi celicami prek spustnega seznama in 
gumbov + in −. 

Koristna je možnost hkratnega urejanja več celic, bodisi z miškinim označevanjem v dokumentu 
bodisi z uporabo tipke SHIFT za večkratno izbiro. 

 
Slika 26: Podatkovna celica v kompleksni tabeli s spojenimi vrsticami naslovnega stolpca mora 
imeti določene tudi informacije o ID-ju njenega naslovnega stolpca/vrstice (npr. »kviz« za sklic 
na celico v prvem spojenem stolpcu in »kviz-vred« za sklic na drugi naslovni stolpec) 

Tako kot pri slikah mora imeti tudi dostopna tabela določeno nadomestno besedilo, ki bralniku 
zaslona posreduje povzetek vsebine tabele kot celote. To uporabnikom omogoča, da že vnaprej 
razumejo, kaj tabela predstavlja, še preden se spustijo v podrobnosti. Nadomestno besedilo za 
tabelo se nastavi prek funkcionalnosti za določanje vrstnega reda branja (    Accessibility > 
Reading Order). Ko je odprto okno Touch Up Reading Order (tabele so prekrižane), lahko z 
desnim klikom na sliko izberemo možnost Edit Table Summary (slika 27), kar odpre vnosno polje 
za opis tabele (angl. Table Summary). 
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Slika 27: Pogovorno okno za dostop do vnosnega polja za zapis nadomestnega besedila za 
tabelo 

🎞️ Dodaten vir: Foxit (2021). PDF Accessibility. How to make tables more accessible in PDF 
documents [Video]. YouTube. 

🎞️ Dodaten vir: University of Oregon (2020). Accessible PDF Tables [Video]. YouTube. 

  Dobra praksa: Ustrezno nastavljeni naslovni stolpci in vrstice že v primarnem dokumentu 
(npr. Word ali Excel; slika 28) pripomorejo k manj zapletom in lažjemu pregledu dostopnosti v 
orodju Foxit PDF Editor, saj program lažje prepozna in uporabi podatke o strukturnih elementih, 
kot so oznake naslovnih celic <TH> in podatkovnih celic <TD>. 

 
Slika 28: Zavihek »Načrt tabele« v MS Excel z določeno naslovno vrstico in stolpcem  

https://youtu.be/C4ZNn4JnETE?si=0EMobUmIwPE6V-EU
https://youtu.be/C4ZNn4JnETE?si=0EMobUmIwPE6V-EU
https://youtu.be/Ea1Xu0iLYdU?si=VBmbcfXS9e_T-hZ6
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9. Dodatne nastavitve in priporočila 
Poleg osnovnih korakov za zagotavljanje dostopnosti PDF-dokumentov se lahko med urejanjem v 
Foxit PDF Editorju pojavijo tudi druge nastavitve, opozorila ali priporočila, ki vplivajo na kakovost 
prikaza, možnosti urejanja ali na splošno uporabniško izkušnjo. 

9.1 Onemogočeno urejanje arhivskega dokumenta (PDF/A) 

Dokumenti, ki so bili ustvarjeni v Microsoft Wordu z izvozom v PDF format, so pogosto privzeto 
pripravljeni za arhiviranje in prikazani v načinu PDF/A. Ta način omogoča bolj stabilno in 
dolgoročno prikazovanje vsebine, vendar onemogoča neposredno urejanje. Za možnost urejanja 
je treba potrditi spremembo v prikazanem pojavnem oknu z izbiro gumba Enable Editing (slika 
29), ali ročno izklopiti v nastavitvah (    File > Preferences > Documents > PDF/A View Mode > 
Never). Po spremembi nastavitev je za uspešno omogočanje urejanja potrebno ponovno zagnati 
Foxit PDF Editor. 

 
Slika 29: Pojavno okno z opozorilom o onemogočenem urejanju zaradi prikaza dokumenta v 
arhivskem načinu PDF/A 

9.2 Ustreznost barvnih kontrastov 

Barvni kontrasti predstavljajo pomemben del vizualne dostopnosti PDF-dokumentov, saj 
bistveno vplivajo na berljivost vsebine – tako za uporabnike z motnjami vida kot tudi pri branju v 
različnih svetlobnih pogojih.  

Foxit PDF Editor ne omogoča samodejnega preverjanja barvnih kontrastov, zato je priporočljivo 
uporabiti zunanja orodja. Ena izmed brezplačno dostopnih in enostavnih možnosti je spletna 
aplikacija WebAIM Contrast Checker (slika 30), ki omogoča vnos barv (v formatu HEX ali RGB) ter 
vizualno oceno skladnosti z merili WCAG (AA/AAA). Po smernicah WCAG za raven AA se kot 
ustrezno razmerje kontrasta za navadno besedilo šteje najmanj 4.5:1, za veliko besedilo pa 
najmanj 3:1. 

https://webaim.org/resources/contrastchecker/
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Slika 30: Pregled ustreznosti barvnega kontrasta s spletno aplikacijo WebAIM Contrast Checker 
za primere »slaba praksa« v tem dokumentu 

Za uporabnike z zmanjšano berljivostjo PDF-vsebin (npr. zaradi disleksije) Foxit omogoča 
prilagoditev prikaza barv (slika 31;     File > Preferences > Accessibility > Document Color 
Options). Nastavitev velja izključno za uporabniški vmesnik in ne posega v vsebino samega 
dokumenta. Uporabniku omogoča izbiro ene izmed prednastavljenih barvnih shem z visokim 
kontrastom (npr. bela na črni, črna na rumeni) ali določitev lastne barve ozadja in besedila. 

 
Slika 31: Prikaz dokumenta v visoko kontrastnem načinu z belim besedilom na črni podlagi ter 
odprtim pogovornim oknom za spremembo prikaza barv (Document Color Options) 
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9.3 Prikaz zrnatega besedila 

Na večjih zaslonih ali monitorjih z visoko ločljivostjo lahko v Foxit PDF Editorju pride do 
popačenega oziroma zrnatega prikaza besedila (slika 32). Tak prikaz zmanjšuje berljivost in lahko 
uporabniku daje vtis slabe kakovosti dokumenta. Eden izmed možnih vzrokov zrnatega prikaza je 
lahko tudi aktivirana nastavitev pomočnika za dostopnost (    Accessibility > Setup Assistant > 
(Use recomended settings and skip setup)), ki vpliva predvsem na nastavitev povezovanja s 
podpornimi tehnologijami. 

Običajen prikaz besedil v dokumentih se uredi v nastavitvah:     File > Preferences > Page 
Display > Rendering > Smothe text For Laptop/LCD Screens in Smooth line art. 

    

Slika 32: Zrnat prikaz besedila, prilagojen uporabnikom s podpornimi tehnologijami v okviru 
nastavitev pomočnika za dostopnost (angl. Setup Assistant) 

9.4 Jezik uporabniškega vmesnika 

Uporabniki lahko spremenijo jezik uporabniškega vmesnika tudi v slovenščino (   File > 
Preferences > Languages). Prevodi manjših jezikov temeljijo na prispevkih skupnosti, ki je za 
slovenščino v tem trenutku pripravljen polovično, zato sprememba ni smiselna. 

9.5 Posodobitev orodja z novo različico 

Za zagotovitev optimalnega delovanja in podpore funkcionalnostim za dostopnost je 
priporočljivo redno posodabljati Foxit PDF Editor na najnovejšo različico. Orodje običajno ob 
zaznavi nove različice prikaže pogovorno okno s pozivom za posodobitev, vendar ta postopek 
pogosto zahteva administratorska dovoljenja in lahko omeji uporabnike brez skrbniškega 
dostopa. Alternativna možnost je ročno preverjanje in namestitev posodobitev neposredno iz 
zavihka za pomoč (    Help > About Foxit PDF Editor > Check for Update).  
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